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Introduction: 

When filming with a Super 8 camera without a tripod you sometimes get blured scenes, especially when one of the furthest tele 
zooms of the camera has been used or when a strong wind was blowing during the shot. With the "Cine Film Image Stabilizer" 
tool those blured scenes can be stabilized to a certain extent. This is done by selecting a significant image detail contained in all 
images of the scene and by assigning defined coordinates to this image detail. The image then is cropped according to this 
coordinates. 

To enable this, all images of the scene must have been extracted by the program S8ToAVI with a certain additional correction 
area (see: S8ToAVI - the "Describe Extraction Parameters" dialog). 

Installation and Invocation of the Image Stabilizer 

The Cine Film Image Stabilizer is provided as a ZIP archive (together with S8ToAVI and Picture Cleaner in the "Super 8 
Cine Film to Video" Suite). This archive contains the Java JAR files with the "Executable" and this help file with the required 
images. 

To install the product simply unpack the archive to a directory of your choice (e.g. D:/PROGRAMS/S8ToAVI ) with a standard 
unpacker like WinZip or PowerArchiver. If not already there, during unpacking, the S8ToAVI directory with all required 
subdirectories will be generated and loaded with the expanded files. 

The Cine Film Image Stabilizer can be started as a tool out of the program "S8ToAVI".  
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In this case the JAR file must be located in the same directory as the JAR File of  S8ToAVI. 

But the program can also be started as independent program. To start the programm as independent program you need to call 
the "JAVA" program provided by the Java Runtime Environment (JRE). The "JAVA" program (java.exe) is located in the 
"bin" subdirectory of the directory to which you have installed the JRE {normally called "jrex.y.z" located in the "c:/programs" 
directory where "x.y.z" represents the version of the JRE (e.g. 1.5.0)}. 

To start the program as independent program you have to enter the following commands into a command screen:  
[ Note: in the provided example it is assumed, that the JRE is in "C:\Programs\Java\jdk1.5.0" (that is inside an installed JDK - a Java Development Kit)  
and imgstbJAR.jar is in "D:\Programs\S8ToAVI" ]. 

D:                        (to switch to drive D) 
cd Programs               (to switch to the user directory) 
C:\Programs\Java\jdk1.5.0\bin\java.exe -Xms128M -Xmx768M -jar D:\Programs\S8ToAVI\imgstbJAR.jar 

Be sure to enter line 3 as ONE single line with no carriage return or line feed. Otherwise the command interpreter of your 
operating system gets a problem.  
 
The parameters -Xms128M and -Xmx768M are required to allocate an appropriate amount of storage for the Java program (in 
this example the minimum amount of allocated storage is 128 MB, and the maximum amount of allocated storage is 768 MB). 
If not used, the program will run out of storage and you get a "not enough storage" exception from the JRE.  
S8ToAVI\imgstbJAR.jar has to be provided exactly as specified here because Java is case sensitive. 

To ease program invocation you can create a "ImgStb.bat" file, or - if Pearl is installed on your machine – a 
"ImgStabilizer.pl" file (content see below, of course adjusted to your installation with respect to the used drives and 
directories). 

 

General Remarks: 

To allow stabilization of movie scenes, the frames must have been extracted from the film strips with some extra space. This 
base image has to be clipped in such a way, that a significant image detail that is contained in all images of the shot gets almost 
identical coordinates in the result images.  
Currently there are allocated by S8ToAVI 30 pixels around the image as extra space for correction. That means, that shocks 
appearing as a 30 pixel shift in the image can be compensated. Larger shocks cannot be compensated completely. For larger 
shocks the maximum compensation of 30 pixels is applied. 

As the image size is selected by S8ToAVI in order to cover as much as possible of the original Super 8 frame, it can happen 
that the additional space in the extended frame covers parts of the frame before and after the actual frame. During stabilization 
this can have the effect, that the upper or lower frame border is not 100% exact. Strong shock compensation may then have the 
same effect as an inaccurately positioned film gate in a projector. To compensate that as well the images can be clipped again in 
a follow up process. The width of the area to be eliminated can be set in steps of 4 pixels in the horizontal image dimension 
which results in a area height of 3 pixels in the vertical image dimension. Clipping (up to a maximum clipping value of 40 
pixels) can be done multiple times until a satisfactory result is achieved.!  
 
Remark: if the generated video will be processed again with a program like Magix VideoDeLuxe, Pinnacle Studio, Adobe 
Premiere Elements or equivalen, then the clipping can be applied also via these programs..  
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The "Image Stabilizer" Main Window 

The "Image Stabilizer" main window controls the workflow during stabilization.  
In the upper part of the window there is the menu bar and the message line and the button bar to control the stabilization 
process.  
Under the buttons bar there are 4 canvases, 3 for images and 1 for a shock analysis graph.  
The left upper canvas will show the start image of a scene to be stabilized.  
The left lower canvas will show the end image of a scene to be stabilized.  
The right (larger) canvas shows (one after the other) the images of the scene to be stabilized in order to be adjusted.  
The shock analysis graph shows for a maximum of 200 frames the size of the resulting horizontal and vertical shifts (max 30 
pixels).  

 

The Menus of the Main Window: 

The "File" Menu 

  

The "File" menu comprises 2 menu items:  
� Prepare for new sequence Via this menu item the handling of a new sequence can be prepared by setting the actual 

selections to the default values.  
� Exit Via this menu item the application will be closed. The acceleration key combination ALT X will also close the 

application.  

The "Special functions" Menu 
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This menu comprises menu items to invoke special functions provided by the image stabilizer. 

1. Redo stabilization using clipping value: Via this menu item a scene stabilization process is repeated automatically (by 
using the shift values stored in the first run). During this run the clipping value set for the horizontal clipping is applied. - 
See  

  
The left and right image border is moved towards the image center by the set value, the upper and lower image border is 
moved towards the image centere by 3/4 of the value. This will keep the image ratio of 4 unchanged.  
Remark: As long as this function is active the computers CPU is busy to almost 100 %, that means, the program will not 
respond until this process has been completed. 

2. Redo stabilization using split value: function not yet implemented.  
3. Start clipped image extraction:.Via this menu item the automatic extraction of the frames of the defined sequence is 

triggered. No stabilization is performed. By that the original frames can be reconstructed in case the stabilization has not 
been satisfactory, e.g. because the shocks to be stabilized have been too strong.  

 
The "Help" Menu 

  

The "Help" menu comprises the menu items to switch on and off the hover help, to display the standard help dialog, and to 
display the about dialog. 

The Buttons of the Main Window 

Right below the menu bar of the main window a message line is shown, that informs about errors occured and about the actual 
status of the image stabilization process. 

Below the message line there is a button bar. The buttons within this bar are the main buttons used to control the stabilization 
process. 

  

1. Button "Set Frame Dir" allows (via the system's file selection dialog) the selection of the directory, that contains the 
images of the movie scene to be stabilized. You have to select a subdirectory that has been created by S8ToAVI for 
extended frames. These subdirectories have names like 1x, 2x, 3x ...etc.  
As soon as a valid selection has been made, the buttons to determine the start- and end frames of the scene are activated.  
 

2. Button "Select start frame" and "Select end frame" allow (via the system's file selection dialog) the selection of the 
first and last frame of the movie scene to be stabilized. The selected images are displayed as thumbnails in the left area of 
the main window. Via the buttons below the canvas a final adjustment of the start and end position can be applied.  
As soon as a valid selection has been made, the related buttons like "End to Start+X", "Advance by X", "Panshot 
Start Pos", and "Panshot End Pos" are activated.  
 

3. The button "End to Start+X" determines the final frame of a scene as the frame, that is positioned X frames after the 
start frame. This is to speed up the selection of the final frame without using the system specific file selection dialog. 
The value X can be set via the first text field ("Advance value X") in the final row of the window. Default value is 10.  
 
See   

 
4. Button "Advance by X" will set the start frame to the actual end frame and the end frame to the frame that is positioned 

X frames after the new start frame. This is to speed up the scene determination without using the system specific file 
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selection dialog. This can be used to set correction segments with a fixed length that can be processed sequentially.  
The value X can be set via the first text field ("Advance value X") in the final row of the window (see above).  
 

5. The buttons "Panshot Start Pos" and "Panshot End Pos" are used to prepare the stabilization by selecting the position 
of a significant image detail that should be used for stabilization and that is contained in the first and last image of the 
scene to be corrected.  
 
With button "Panshot Start Pos" the first image of the scene to be corrected is shown, in order to select this significant 
image detail by clicking on it with the left mouse button.  
 
With button "Panshot End Pos" the last image of the scene to be corrected is shown, in order to select the same 
significant image detail by clicking on it with the left mouse button.  
 
The straight line determined by the selected positions defines the path on which the "significant image detail" moves 
along in the case of panning shots.  
It must be mentioned, that with the tool only short and straight panning shots can be stabilized (about 80% of the image 
height respectively image width), because the available correction area is very limited. Longer panning shots must be 
segmented if necessary. The best effect is achieved for scenes which are not panned.  
The example shows a unfavourable (left) and a favourable (right) panning shot. To stabilize the scene, the unfavourable 
panning shot should be divided at the peek of the panning curve. 

 

As soon as a valid determination of the start and end position has been performed, the button Start Manual Stabilization 
is activated. 

6. Button Start Manual Stabilization: starts the scene stabilization process by presenting the first frame of the scene. By 
clicking onto the selected "significant" image detail with the left mouse button the frame will be positioned, extracted, 
and stored in the target directory. Then automatically the next frame of the scene will be presented until the last frame has 
been reached.  

Additional Buttons of the Main Window 

The main window comprises 4 groups of buttons. 

1. Group 1: The buttons of group 1 below the canvas that presents the start image allows fine adjustment of this start 
image. The buttons allow to select images before and after the actually presented image. Single step and jumps of 10 
frames are supported in both directions.  
 

2. Group 2: The buttons of group 2 below the canvas that presents the end image allows fine adjustment of this end image. 
The buttons allow to select images before and after the actually presented image. Single step and jumps of 10 frames are 
supported in both directions.  
 

3. Gruppe 3: The buttons of group 3 below the canvas that shows the analysis graph allow the selection of the image, at 
which a panning shot should be divided. With this buttons you can move the red seperation line back and foreward. In the 
field between the buttons the file name of the actually selected image is shown.  
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4. Group 4: With button "Show Src" the scene will be presented in slow motion based on the original (not stabilized) 
images. With button "Show Res" the scene will be presented in slow motion based on the corrected images.  
With button "Exit" the tool will be terminated.  

 

The Recommended Workflow to Stabilize Movie Scenes 

1. Select the directory containing the image sequence to be stabilized via button "Set Frame Dir".  
In the upcoming file selection dialog mark the frames directories subdirectory that has a name ending with a "x".  

2. Select the first frame of the sequence, that should be stabilized or extracted via button "Set Start Frame"  
By using the buttons under the upper left image control window, you can fine-adjust the start frame selection.  

3. Select the last frame of the sequence, that should be stabilized or extracted via button "Set End Frame"  
By using the buttons under the lower left image control window, you can fine-adjust the end frame selection.  

For plain frame clipping (without stabilization): 

1. Start extraction via "Special functions -> Start clipped image extraction".  

For image stabilization: 

1. Select the start position in the start image via button "Panshot Start Pos"  
Choose a significant point in the image and select it by clicking onto it using the left mouse button.  

2. Select the end position in the end image via "Panshot End Pos".  
To do that click onto the same significant point in the end image using the left mouse button. This is needed to 
compensate a potential panning movement in the image sequence to be stabilized.  

3. Start the stabilization via button "Start Manual Stabilization".  
4. The source images of the sequence are now presented in ascending consecutive order.  

To stabilize the sequence, mark your selected significant point in each image by clicking on it using the left mouse 
button.  
The message line shows an information message when the last image has been reachend. 
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5. If the movie has to be stabilized in fixed segment mode, than you can step through the movie via button Advance by X. 
The step width X is determined via field Advance value X.  

Stabilization verifiation: 

The effect of the stabilization action can be verified by pressing the buttons "Show Src" respectively "Show Res".  
The source images respectively the result images are presented in order to verify, that the stabilization has been performed 
correctly. 

If during verification strong disturbances at the image borders are recognized you can set a clipping value to trim the images in 
order to remove the jammed areas. 

  

The horizontal clipping value is set via the +4 and -4 buttons. The vertical clipping value is always 75 % of the horizontal 
value.  
By repeating the extraction (menu item Perform Extraction -> Redo stabilization using clipping value) the jammed areas 
can be eliminated up to a maximum horizontal width of 40 pixels at each side and a maximum height of 30 pixels at the top and 
bottom of the image. 

Last changes: March 17, 2007 WK 
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